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Collaboration 10.5 v1 

Cisco Unified Attendant Console Advanced / 

Cisco Emergency Responder 
最近更新: 10-09-2014 

关于此演示 

预设置的演示包括： 

 一个脚本场景演示了  Cisco Unified Attendant Console Enterprise Edition 如何提供人类话务台操作，利用工具通过组织迅

速接受并有效地调度来电到个人。  

 一个脚本场景演示了 Cisco Emergency Responder 如何确保紧急救援人员可以找到，并协助 911 呼叫，同时生成警报给上

门服务人员。 

 为客户环境的仿真管理访问级别，以自定义演示演示环境 。 

演示需求 

下表列出了本演示中预配置的要求。 

表 1. 演示需求 

必需 可选 

● 路由器，已注册并配置的 dCloud 

● 笔记本电脑 

● Cisco Unified IP Phones 

o 6941 

o 9951 

o 9971 

o DX650 

● 苹果 iPad 

演示配置 

这个演示包括预配置用户和组件来说明脚本的场景和 Collaboration 10.5 Cisco Unified Attendant Console Enterprise Edition 解决方

案的功能。完成示例场景中所需的所有访问信息都位于您运行的演示的拓扑结构（Topology）和服务器（Server）菜单中。 

 Topology Menu. 单击任何拓扑中的服务器，以显示可用的服务器选项和认证。 

 Servers Menu. 单击  或 旁边的任何服务器名称以显示可用的服务器选项和认证。 
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表 2. 演示预配置的用户信息 

User Name User ID Password 角色 端点设备 电话 分级 

Adam McKenzie amckenzie dCloud12345! 控制台接线员 

现场安全响应程序 

Cisco 9971 or DX650 

Workstation 1  

+1 408 555 6016 6016 

Anita Perez aperez dCloud12345! 911 呼叫者 Cisco 9951 

Workstation 2 

+1 408 555 6017 6017 

Charles Holland cholland dCloud12345! 911 接线员 Cisco 6941 

Apple iPad 

+1 408 555 6018 6018 

注意： 表 2 中列出的设备是基于预定义的情景而提出的。由于 Cisco Unified Communications Manager 里的 Self-Provisioning 的

功能，任何设备根据可用性可以分配给任何用户。 

表 3. 演示服务器信息 

演示拓扑 

此演示包含几个服务器虚拟机。大多数服务器是完全可使用管理级别帐户配置。管理帐户详细信息包含在脚本的有关步骤中，及在

服务器详细信息表。 

应用程序 版本 URL Username Password 

Cisco TelePresence Conductor Server XC2.3 http://198.18.133.206 admin C1sco12345 

Cisco TelePresence Server 4.0 (2.8) http://198.18.133.209 admin C1sco12345 

Cisco Prime Collaboration Server 10.5(1) http://198.18.133.108 globaladmin dCloud12345! 

Cisco Unified IM and Presence Server 10.5(1) http://198.18.133.4 administrator C1sco12345 

Cisco Unified Communications Manager 10.5(1) http://198.18.133.3 administrator C1sco12345 

Cisco Emergency Responder 10.5(1) http://198.18.133.167 administrator C1sco12345 

Cisco Jabber Guest Server 10.0.1.216 http://198.18.133.222 admin dCloud! 

PostgreSQL Message Archiving Server  1.18.1 http://198.18.133.217 administrator dCloud12345! 

Cisco Unified Attendant Console Advanced  10.5(1) http://198.18.133.35 administrator C1sco12345 

Cisco Prime Collaboration Assurance 10.5(1) http://198.18.133.175 globaladmin dCloud12345! 

Cisco Unity Connection Server  10.5(1) http://198.18.133.5 administrator C1sco12345 

Cisco Media Sense Server  10.5(1) http://198.18.133.186 administrator C1sco12345 

Cisco Unified Contact Center Express Server 10.5(1) http://198.18.133.19 administrator C1sco12345 

Cisco WebEx Meetings Server 2.0 2.0.1.107.B-AU http://198.18.133.150 administrator C1sco12345 

Cisco WebEx Meetings Server IRP 2.0 2.0.0.1481.B-AE http://198.18.133.151 administrator C1sco12345 

Microsoft Active Directory Server 2008 R2 SP1 http://198.18.133.1 administrator C1sco12345 

Microsoft Exchange Server 2008 R2 SP1 http://198.18.133.2 administrator C1sco12345 

Workstation 1 Windows 7 Pro http://198.18.1.36 DCLOUD\amckenzie dCloud12345! 

Workstation 2 Windows 7 Pro http://198.18.1.37 DCLOUD\aperez dCloud12345! 

Workstation 3 Windows 7 Pro http://198.18.1.38 DCLOUD\mcheng dCloud12345! 

CSR Workstation Windows 7 Pro http://198.18.1.39 DCLOUD\chegarty dCloud12345! 

http://198.18.133.206/
http://198.18.133.209/
http://198.18.133.108/
http://198.18.133.4/
http://198.18.133.3/
http://198.18.133.167/
http://198.18.133.222/
http://198.18.133.217/
http://198.18.133.35/
http://198.18.133.175/
http://198.18.133.5/
http://198.18.133.1/
http://198.18.133.1/
http://198.18.133.150/
http://198.18.133.151/
http://198.18.133.19/
http://198.18.133.2/
http://198.18.1.36/
http://198.18.1.37/
http://198.18.1.38/
http://198.18.1.39/
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图 1. 演示拓扑综述 

 

演示准备 

 

演示前 

我们强烈建议，在您将此演示呈现给在现场观众前，必须至少自我演示一次此全部过程。这会让您熟悉文件的结构和此演示。 

准备工作是客户展示成功的关键。 

请按照下面的步骤来安排并配置您的演示环境。 

1. 注册和配置端点路由器，如果这是您的第一次将为 dCloud 使用您的路由器。[如何操作] 

2. 预约演示 [如何操作]. 

3. 在执行任何方案之前在演示地点测试您的带宽接入。 [如何操作]  

4. 确认您的会话在思科 dCloud UI 上我的仪表板（My Dashboard）页面上我演示（My Demonstrations）下的状态为活跃（

Active） 。 

 您的演示开始活跃可能将花费您 35 分钟的时间。 

5. 连接您的路由器 [如何操作] 

6. 可选： 通过演示 Workstations 使用您本地的 RDP program 或 Cisco dCloud Remote Desktop Client [如何操作]. 如果您使

用多台笔记本电脑，请将每台都连接到工作站。 

 Workstation 1 (198.18.1.36), User: dcloud\amckenzie, Password: dCloud12345! 

https://dcloud-cms.cisco.com/help/register-and-configure-router-chinese
https://dcloud-cms.cisco.com/help/schedule-demonstration-chinese
https://dcloud-cms.cisco.com/help/test-your-connection-chinese
https://dcloud-cms.cisco.com/help/connect-router-and-laptop-chinese
https://dcloud-cms.cisco.com/help/using-remote-desktop-client-chinese
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 Workstation 2 (198.18.1.37), User: dcloud\aperez, Password: dCloud12345!  

7. 配置电话，在此演示用使用的 Self-Provisioning 功能现在在 Cisco Unified Communications Manager 10.5 是可使用的 [如

何操作]. 使用表 2 中的扩展列表为电话做资源调配。 

 Adam McKenzie: 9971 or DX650 

 Anita Perez: 9951 

 Charles Holland: 6941 

8. 将您的 Unified IP phone 9971 和 CUACA 应用程序做关联。  

注意： 如果您是使用 Cisco Jabber for Windows 作为您的通讯设备，您不需要关联此设备，因为它已经被关联为 CUACA 的默认用

户。 

a. 在 Workstation 1，开启 Internet Explorer 并浏览 Collaboration Admin links > Cisco Unified Communications 

Manager。用以下认证登录 Cisco UCM ： Username: administrator, Password: C1sco12345. 

b. 单击 User Management > Application User.  

c. 输入下面的搜索条件，以查找 cuaca 应用程序用户，单击 Find.  

 

d. 在搜索结果上单击 cuaca User ID 。  

e. 在 Application User Configuration 窗口，向下滚动到 Device Information 部分。 

f. 在 Available Devices 列表，选中 Adam McKenzie’s phone。设备的名称格式为 SEPXXXXXXXXXXXX, 设备名称始于 

SEP 和其余的内容是该设备的 MAC 地址。 

 单击该设备，再单击向下的箭头以添加设备到 Controlled Devices 列表，然后单击 Save.  

 登出 Cisco UCM. 

 关闭 Internet Explorer. 

9. 为 Charles Holland 配置 Jabber for iPad 作为移动设备。[如何操作] 

10. 当您开启 Cisco Unified Attendant Console Advanced，您将被提示它正在运行评估副本。单击 OK 继续。如果您将演示延长到 

5 天之外，服务器在许可证到期后，必须重新启动。 详细信息请查看附录 A 。  

https://dcloud-cms.cisco.com/help/cisco-unified-communications-manager-10-0-self-provisioning-chinese
https://dcloud-cms.cisco.com/help/cisco-unified-communications-manager-10-0-self-provisioning-chinese
https://dcloud-cms.cisco.com/help/install-configure-and-test-access-to-cisco-jabber-for-ipad-chinese
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场景 1： 话务台 

这个演示方案说明了视频设备制造公司如何使用 Cisco Unified Attendant Console Advanced 来有效地处理传入呼叫。 

演示步骤 

步骤  谈话要点 操作 

1 我是 Adam McKenzie 是一家视频设备制造公司的

控制台话务员。让我来告诉您在我们的业务中如何

处理传入的呼叫。  

我的一天从登录 Cisco Unified Attendant Console 

Advanced 开始。 

 在 Workstation 1 上，用桌面快捷方式启动 Cisco UAC 

Advanced 。 

 单击 File > Login 并输入 Username OP1 和 password 

C1sco12345. 

 确认 Extension 已被设置 +14085556016. 

 单击 Login. 

2 我看到在控制台中的目录使用按预定时间的 UCM 同

步 ；在此目录中的任何用户必须作为 UCM 最终用

户存在。 

作为操作人员，很可能为我添加的职位名称、 位

置、 备注及联系号码等每个联系人的其他信息。  

作为信息存储在 Cisco Unified Attendant Console

服务器上，由一名话务员输入此信息后，所有话务

员立即可用。 

亮点: Cisco Unified Attendant Console Premium 

Edition 支持与 Active Directory 同步 — — 这尤其

有用的是自动添加更多详细信息到目录 。 

 

 使用 Last Name 搜索栏，输入名字 Adams. 

 在 Tanya Adams’ contact 上点击鼠标右键，并点击 Contact > 

Contact Details 或在键盘上按 F12 。 

 通过 UCM 填充灰显字段，这些不能在 Attendant Console 

Directory 中更改。 

 请注意所有附加字段您都可以输入信息。 

 点击 Alternate Contacts 并单击 Add 以添加一个联系人在

Assistant 和/或 Alternate. 

 单击 Notes 并在 Contact Information 和/或 Contact Absent 

Message 下添加备注，单击 OK.  

 有三种颜色，每个都有其自己特定的含义： 

o 红色 -联系人有一名助手已在在可替换联系人中被定义

了。这将优先于蓝色和绿色。 

o 蓝色 – 联系人已添加一个或多个可替换联系人（但不是

助手）到可替换联系人中 

o 绿色 -联系人具有 2 个或更多额外的联系号码 

 在目录，您回看到有红色箭头的联系人和备注图标，悬停在联系

人上,以查看备注。  

 蓝色的箭头表明 Alternative Contacts 存在。在键盘上按 F2 或

在联系人上点击鼠标右键并单击 Contact > View Alternate 

Numbers with Presence.  
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步骤  谈话要点 操作 

3 在默认情况下，我能看到 Cisco Unified Attendant 

Console 目录中的所有联系人。您可以创建您自己

的个人目录组（Personal Directory Groups）区分

联系人，以便您自己更快地访问组里的人。如果您

配置一个筛选器，这些组将动态更新用户。 

亮点： 话务员创建的个人目录组将不会被其他操作

人员看到或共享。 这些目录组是所有目录的子集， 

同步于 Cisco Unified Communications Manager. 

因为个人创建的组使用活动的目录筛选也可以拖动

和删除单个联系人，话务员可以确信他们组始终是

最新的。 

 在目录窗口的任何地方点击鼠标右键并单击 Personal Directory 

Group > New. 

 在 Name 字段, 输入一个组的名字 My Engineering Group. 

 在 Description 字段，输入 Engineering 作为描述。  

 在 Filter 区，单击 Field 下面的 Department ，单击 is equal 

to 并在 Value 字段输入 Engineering。 

 单击 OK 以创建新的组。 

 新组将显示为目录窗口中的新选项卡。 

您可以从 Personal Directory Group 里的 Full Directory 通过拖拽

手动添加联系人到组里。 

4 作为话务员，还有可以用 Attendant Console 为我

创建快速拨号。这给了我在 Attendant Console 中

有号码的选项，这是不存在 UCM 的。我能创建没

有别的话务员可以看到的个人快速拨号（Private 

Speed Dials ）， 或者我可以创建所有的话务员都

能看到的全球快速拨号。 

 在 Speed Dial 段里的任何地方点击鼠标右键，并单击 Add 

Speed Dial. 

 在 Number 字段，输入电话号码。 

 在 Name 字段，输入联系人名字。 

 在 Company 字段，输入公司的名字。 

 离开已选择的 Private Speed Dial 框，使该条目专用于话务员创

建条目。 

 单击 Ok. 

 单击 Yes. 

注意： 如果您需要演示快速拨号功能，在您的演示环境中，按照拨号

模板输入一个有效的手机号码。然后双击条目拨打。 
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步骤  谈话要点 操作 

5 在我们的生意中至关重要的是用最快的速度第一时

间将呼叫调配到正确的对象。 

使用 Cisco Unified Attendant Console, 我有两种方

式看到可用用户的可见性。使用可用的两种方法，

我可以一个正确的决定把一个呼叫传送或寻找替代

联系人。 

Cisco Unified Attendant Console 集成 Cisco 

Jabber for Windows, CUP, Microsoft OCS, 

Microsoft Lync, 和 iLink for Cisco ，这让我可以看

到用户的状态信息如： Available, Away, Do Not 

Disturb 以及任何由用户设置的自定义消息。 

也可以让我看到一个联系人电话的 Busy Lamp 

Field (BLF) 状态。这是联系人电话的实时状态，让

我看看它们是否空闲，忙线中，呼叫转移，或设置

为请勿打扰( Do Not Disturb)。 

 在 Workstation 1 单击 Full Directory 项。 

 用 Last Name 搜索框，输入名字 Perez. 注意状态指示符显示

Anita 是 Offline. 

 在 Workstation 2，登录并开启 Cisco Jabber 或 Google 

Chrome 浏览器。您将做为 Anita Perez 自动登录。 

 在 Workstation 1，注意状态指示符变为绿色并指示 Available.  

 在 Cisco Jabber 里更改状态到 Do Not Disturb 观察到目录中

的变化，变为红色。 

 在 Cisco Jabber 里更改 custom message，在 Attendant 

Console 里悬停在联系人上，并查看显示的信息。 

 将 Anita 桌上话机摘机，并注意联机状态图标将更改为 On the 

Phone。如果您使用 Cisco Jabber for Windows 或 Esna iLink 

for Cisco, 打个电话以显示摘机状态。 

6 使用 Cisco Unified Attendant Console，我能有几

个列队帮助我区分我收到的呼入类型及区分我是否

接听电话。我有内线列队、外线列队和语音邮箱分

组列队。  

所有的列队都配置他们自己的呼叫传递模式： 

Broadcast delivery 会将呼叫呈现给所有的使用 PC

应用程序的话务员；此时电话呼叫会在列队中响铃

（是通过 PC 扬声器发出响铃提示 ）此时呼叫不会

在电话上响铃。 

Forced delivery 会专注于最高优先权呼出列队并

在话务员的电话上响铃。如果话务员 10 秒钟内没有

应答，呼叫会被发送到其他话务员。 

请注意这个演示系统的列队设置在 Broadcast 

delivery 里。 

每个列队也能在它自己的溢出目的地中被设置。在

无话务员登录；呼叫等待；很多呼叫在列队中，或

者紧急情况的基础上，呼叫可以溢出。溢出目的地

可以是任何目的地可以被 Cisco UCM 拨号的。 

在 Workstation 1, 配置列队: 

 启动 Firefox.  

 在 dCloud 页面，选择 Collaboration Admin Links > Cisco 

Unified Attendant Console Advanced.  

 用以下认证登录： Username: ADMIN and Password: 

C1sco12345. 

 导航到 User Configuration > Queue Management. 

 单击 Find. 

 为 External 列队单击 Select.  

 注意为外部列队配置溢出设置。 

注意： 不要更改 DDI 号码并且不要与 CUCM 同步。 Forced delivery

选项只有在创建队列可用时，一旦已经创建了队列，它不能更改， 

并且这就是为什么它灰色。 
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步骤  谈话要点 操作 

7 每个列队都能被配置它们自己的优先权。这意味系

统可以基于列队的优先权自动排序呼叫。如果列队

的优先权相等，则优先处理等待时间最长的呼叫。 

称呼也可以配置和这些帮助我知道如何去接听电

话。如果针对队列配置了的称呼，当我从该列队中

接听一个呼叫时，这个称呼会弹出。这将确保我合

理地接听电话。  

 返回 Queue Management 屏幕，并单击 Internal 列队。 

 注意 Internal 列队的 Priority 被设置为 50. 

 返回 Queue Management 屏幕，并单击 External 列队。 

 注意 External 的 Priority 被设置为最低值： 99.  

 现在优先权已经被设置好了，内部列队中的呼叫会比外部列队中

的呼叫获得优先处理权。 

 调整 External 优先权到 25 并单击 Save. 

 请注意每个队列可自定义的称呼 (Salutation) . 

注意： 不要更改 DDI 号码，也不要与 CUCM 同步。 

8 队列可以与不同的话务员帐户相关联。这意味着系

统可以部署以隔离呼叫，所以话务员只能看到某些

呼叫。 

作为示例，一个组织可能有两个办公地址 (Office A 

and Office B). 在每个地方的话务员只能看到他们本

地的呼叫。使用 Cisco Unified Attendant Console, 

通过指派相关的列队给相关的话务员，这个就很容

易完成了。 

 

 在 Cisco Unified Enterprise Attendant 菜单，选择 User 

Configuration > Operator Management.  

 单击 Find. 

 单击选项链接，选择用户 OP1 比查看连接的列队。 

9 作为话务员，对我来说很重要的是为了提供高质量

的客户服务，必须快速接听呼叫。  

呼叫在显示在我们的屏幕上之前，先由系统排列优

先权。呼入以优先权的降序排列被显示在 Queued 

Calls Area (F8). 使用 Answer Next, 我可以由系统

设置的优先次序应答电话。这种方式下最高优先权

的呼叫将被第一个应答。 

使用 Cisco Unified Attendant Console, 我又多种方

式应答呼入电话号，可以使用我的键盘，也可以使

用鼠标。 

亮点：所有的话务员任务可以用下面四种方式中的

一种来完成：使用键盘快捷方式，拖拽一个呼叫从

一个地方到另外一个地方，点击鼠标右键执行或使

用 Call Control 图标。 

 

 通过从演示电话 DN 7600 拨打，安排一个 Internal 列队里的呼

叫。  

 等待几秒并从别的设备拨打一个电话到 External 列队，通过

DID 相关联的 DN 7800 拨打。 

 在先前步骤中，外部队列配置优先级高于内部队列中。因此，对

外部队列的呼叫将显示在列表的顶部，尽管内部呼叫是优先的 

注意： 如果列队优先权相同，呼叫将按照收到的先后次序排列。 

 在数字键盘上按 “+” 键以应答下一个优先权最高的呼叫。 

 一个 Salutation 的弹出窗口会在您应答呼叫时弹出。  

 End 此呼叫。 

 生成额外的呼入，并演示每个应答的方法： 

o 双击呼入 

o 把呼叫从 F8 拖到 F7. 

o 在 Queued Calls Area (F8) 单击鼠标右键并单击 

Answer Next. 
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步骤  谈话要点 操作 

10 作为一个繁忙的话务员，同时处理多个呼叫是很重

要的。在很多场景中，我会快速应答呼叫和安排在

等待接听，这种方法下呼叫被应答代替了呼叫必须

等待。 

我也可能呼叫安排在等待接听中，如果他们的目标

用户正在现在正忙，忙线中或他们的 Jabber 状态

显示为不可用。 

有时候我需要一个备注当安排一个呼叫为等待接

听。我能用键盘或我的鼠标完成这个工作。 

 在 Internal 内部列队中拨打电话，通过演示电话拨打 DN 7600  

 在数字键盘上按 “+” 键，以接听下一个最高优先权的呼叫 

 通过点击鼠标右键安排一个呼叫为等待接听， 单击 Hold, 将呼

叫从 F5 area 拖拽到 F7 area 或在呼叫控制工具栏单击 Hold 

Call  图标. 

 安排一个 External 列队呼叫，通过拨打与 DID 相关联的 DN 

7800. 

 在数字键盘上按 “+” 键，以应答下一个最高优先权的电话。 

 从目录中选择一个用，并用上文描述的一种方法安排一个等待接

听。  

  呼叫被等待。信息指示在 F5 区域 该呼叫等待，以及他的 BLF 

状态。这使您可以看到它们是可用来接听的电话。 

 End 呼叫。 

 生成额外的呼入，并用备注的方法演示每个等待  

o 点击鼠标右键并选择 Hold with Notes. 

o 在呼叫控制工具栏单击 Hold with Notes 图标 



  

 

 
Cisco dCloud            

 

 

 
dCloud: The Cisco Demo Cloud            

 

© 2014 Cisco and/or its affiliates. All rights reserved. This document is Cisco Public Information. Page 10 of 15 

步骤  谈话要点 操作 

11 呼叫转移的易用性是重要的。对我们的业务至关重

要的是需要尽可能快地第一时间与合适的人通话。 

使用 Cisco Unified Attendant Console，这让我可

以执行一个混合的 盲转（Blind Transfers ） 和 

Consultation Transfers 到人们的目录里，以一个输

入的数字、 快速拨号或切换联系人的其他号码。 

使用一个盲转（ blind transfer），我将没有说明目

的地的用户呼叫转接给任一目的地。 

如果我需要先一个呼叫，可以执行 Consultation 

Transfer. 

我也能用同样转移操作，快速拨号、更改号码或一

个我自己输入自己的号码. 

 

 从 Attendant Console 菜单， 单击 Options > Preferences > 

Call Transfers. 

 描述操作。一个用户可以配置控制台以执行一个盲转（ blind 

transfer） 或一个有目的转移（consultation transfer）用拖拽或

双击的方法。  

 安排一个 External 列队的呼叫从外部电话拨打 DN 7800 。 

 Answer 在控制台上传入的呼叫。 

 使用 Full Directory search 字段, search 搜索联系人，您可以

转接的要求，在这种情况下选择 Anita Perez. 在搜索结果中的

Anita Perez 点击鼠标左键。 

 选择一个中性模式 Blind Transfer 以演示以下内容： 

o 双击联系人 Anita Perez. 

o 拖拽一个呼叫到 Anita Perez. 

o 在 Anita Perez 的联系人点击鼠标右键，单击 Blind 

Transfer. 

 安排一个 External 列队的呼叫从外部电话拨打 DN 7800 。 

 Answer 在控制台上传入的呼叫。 

 使用  directory search 字段, search 搜索联系人，您可以转接

的要求，在这种情况下选择 Anita Perez. 

 按 Enter 键安排一个等待接听和一个到最终目的地的输出呼叫。  

 演示 Consultation Transfers 到联系人： 

o 按数字键盘上的 “+” 切换呼叫, 点击鼠标右键并单击 

Toggle 或单击控制工具栏上的 Toggle 图标。 

o 删除咨询转接（ consult transfer），按数字键盘上的 “-

“ 键，点击鼠标右键 并单击 Clear 或单击在控制菜单栏

上的 Clear 图标 。 

o 完成转移，, press the Enter key again, 点击鼠标右键 

and 单击 Complete Transfer 或单击 在控制工具栏上

的 Transfer Call 图标。 
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步骤  谈话要点 操作 

12 有时通过最终的目的地，可能不应答转移的通

话， 。在此情况下，呼叫返回给我，以便我可以提

供转接到另一个位置。 

也有的时候可能失误将呼叫转移到不正确的人；通

过这个系统，我可以很容易回收转移，只要不应

答。 

 安排一个呼叫在 Internal 列队，通过演示电话打到 DN 7600  

 Answer  接入的呼叫. 

 用 directory search 字段 Lookup 内部列队。 

 执行一个 Blind Transfer 到用户目录。 

 不接听呼叫并在键盘上按 Ctrl + r 取回呼叫。 

 再次 Transfer 呼叫，在最终目的地上不要接听呼叫。30 秒后，

呼叫会转入语音邮件。  

13 一些我们的联系人即使离开他们的工作台还是有责

任在身的。对这些移动用户来说，接听呼叫非常重

要。 

使用 Cisco Unified Attendant Console, 这个将很容

易让我将一个呼叫绑定给一个用户。用户可以用任

何电话拨打绑定号码 并与其他人联系。 

 安排一个呼叫在 Internal 列队，通过演示电话打到 DN 7600  

 Answer  接入的呼叫. 

 Park 呼叫通过按键盘上的 Home 键，点击鼠标右键并选择 Park 

Call 或单击控制工具栏上的 Park Call 图标。 

 呼叫会从 F7 区域到 Call Park 区域，并且其中一个图标会便回

绿色。请注意 Parked call 的电话分机号码。 

 从另外一个电话呼叫 call park 的号码以联系呼叫者。 

14 知道有多少呼叫是被控制在 Attendant Console，这

点很重要，这决定了需要用多少话务员去服务打入

的呼叫。 

 启动 Firefox.  

 在 dCloud 主页，选择 Collaboration Admin Links > Cisco 

Unified Attendant Console Advanced. 

 用一下认证登录： Username: ADMIN and Password: 

C1SCO12345. 

 在屏幕的右上角的导航菜单中使用下拉框，并单击 Cisco 

Unified Reporting 并单击 Go. 

 

 单击 System Reports. 

 单击 Operator Calls by Queue 报告。 单击 External 和 

Internal queues 的 OP1 然后 Generate Report. 

 报告将被打印或输出为一个 Excel 或 PDF 文件。 

 显示其他报告或可用参数。 
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场景 2: Cisco Emergency Responder 

这个场景 将说明 Cisco Emergency Responder 如何帮助确认 Cisco Unified Communications Manager 发送紧急呼叫到呼叫者本地

的适当的 Public Safety Answering Point (PSAP) ，并且 PSAP 如何识别本地呼叫，如果必要，回拨。 Cisco Emergency 

Responder 也能在紧急呼叫的过程中注意到一个地方的个人安全和呼叫者所在地。  

注意： 在演示中，Charles Holland 扮演里 911 话务员。这个系统配置里 911 呼叫线路给 Charles Holland 的分机。所以虚拟的 911

电话，不会连线到真正的紧急责任人。在此演示中我们不推荐拨打外线的 911 电话。  

演示步骤 

步骤 谈话要点 操作 

1 我是  Adam McKenzie 除了控制台话务员之外，我

也是我的大楼现场安全联络人 。 

使用 Cisco Emergency Responder，我得到我需要

查明并立即协助紧急呼叫者的信息。还有我需要把

本地的信息直接告诉消防、 警察、 或救护车服

务，当他们到达时。 

让我们看看我们在这栋建筑在这里处理的最近的紧

急呼叫 。 

在 Workstation 1 (作为 Adam McKenzie),  

 用 username amckenzie and password C1sco12345 登录 

Outlook. 

 启动 Cisco Jabber. 您会作为 Adam McKenzie 自动登录。 

 从桌面快捷方式启动 Attendant Console。 

 单击 File > Login 并输入 Username OP1 和 password 

C1sco12345. 

 单击 Login. 

注意：确保 NumLk 不在 on 上。 

在 Workstation 2 (作为 Anita Perez), 

 用 Esna iLink 启动 Cisco Jabber 或 Google Chrome 网页浏览

器。您可以自动作为 Anita Perez 登录。 

 确保 Cisco IP 电话 6941 或 Apple iPad 已经注册 Charles 

Holland 在 x6018. 

2 最近我们的办公室遇到情况，Anita Perez 头晕和呼

吸急促。她担心这会时很严重的事情，于是拨打了 

911，立刻得到了帮助。 

她告诉了 911 接线员她的症状的详细信息。当她在

提供确切的所在地地址时，她有点困惑和麻烦。 

当生成 911 急救电话，除了将呼叫传送至 PSAP, 

为指定的现场安全联系人，Cisco Emergency 

Responder 生成一个呼叫给我. 

我可以使用在录音中所提供的资料，将她确切的位

置打电话告诉 Anita 或直接告紧急救援人员。  

 在 Anita Perez 的 9951, Cisco Jabber, 和 iLink 客户端，拨打

911.  

 Charles Holland 的 6941  或 iPad (作为 911 话务员使用) 会响

起。Answer 呼叫。 

 一个呼叫将在控制台话务员处生成。  

注意： 如果您没有打电话给 Charles Holland, 您会听到一段预先录制

的信息。这不应影响的全面展示。 

在 Workstation 1 (作为 Adam McKenzie),  

 在话务员操作台，接听呼叫并听听紧急呼叫的详细信息的录音和

呼叫位置。 
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步骤 谈话要点 操作 

3 作为一项额外的预防措施，Cisco Emergency 

Responder 已经被配置了任何时候当一个 911 呼叫

被拨打，就发送给您一封邮件。由于我可以用智能

手机接收邮件，这封邮件在我离开我的办工作桌时

特别有用。  

邮件内容包括了紧急呼叫者的身份，以及他的分机

和位置。 

但是如果我需要额外的 Anita 的位置信息详情，我

要打开邮件提供的链接，以查看 CER 真实数据。 

所有的记录包含一个 ELIN. ELIN 数字被安排在每个

开关上，或每个位置上并且被 911 话务员使用，以

确定呼叫从哪里来。如果电话断开或通知的电子邮

件未生成时，这会是很有用的。   

我可以拨出这个数字联系到紧急呼叫者。 

此界面还允许我确认每个紧急呼叫，以确保每个事

件已被处理。 

在 Workstation 1 (作为 Adam McKenzie),  

 在 Outlook Inbox，打开在 Inbox 里的 CER 文件夹。 

 在 CER 文件夹，从 CER (cer@dcloud.cisco.com) 里打开标题

是 Emergency Call Alert. 该信息包含了拨打 911 呼叫的 Anita

详细信息。 

 单击包含在电子邮件消息中的超链接。 

 作为 Username amckenzie 和 Password C1sco12345 的用户

登录 Cisco Emergency Responder 。 

 在呼叫列表中， 单击 您为这次演示拨打的呼叫。 单击 Call 

Time 链接，打开呼叫记录。 

 指出额外信息包括大楼名字，街道名字，位置等。 

 关闭弹出窗口。 

 单击 Acknowledge 链接以说明紧急呼叫已被协助。 

 单击 OK. 

 刷新页面显示呼叫被确认。 
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附录 A: Release Notes 和 Workarounds 

1. 在默认情况下，此演示环境中，BLF Phone 状态是不工作的。 查看 BLF 状态，添加每个要监视电话的 MAC 地址。 

a. 执行给定用户的目录搜索。 

b. 按 F12, 以打开联系人详细信息。 

c. 单击 Contact Numbers.  

d. 单击 User device name 框，输入用户电话的 MAC address 。  

注意： MAC address 必须被输入如 SEPXXXXXXXXXXXX. 

2. 如果现在不能正确显示所有用户: 

a. 去到 Options > Preferences > Presence.  

b. 为 Cisco Presence Status 单击收音机键，然后单击 OK. 

3. 如果任何 CUACA 号码都是忙音，重启 CUACA 服务器。  

a. 在您的演示工作站，启动 Internet Explorer 并浏览 Collaboration Admin Links > Cisco Unified Enterprise Attendant 

Console.  

b. 用以下认证登录： Username: ADMIN, Password: C1sco12345.  

c. 在菜单中，单击 Engineering > Service Management 并单击 Cisco Unified Attendant Server 的暂停键。单击 OK.  

d. 单击 Start 键，重新启动。 单击 OK. 

4. 如果 BLF 存在不准确，您可能需要添加被监视的电话。 

a. 登录 Internet Explorer ，并从 Cisco Demo dCloud homepage 导航到 Collaboration Admin links > Cisco Unified 

Communications Manager.  

b. 用以下认证登录： Username: administrator, Password: C1sco12345.  

c. 在菜单中， 单击 User Management > Application Users.  

d. 搜索用户 cuaca. 

e. 单击  find more phones 并点击您想要监控的电话的框。  

f. 单击 Add Selected 并 Save 更改。  

g. 登出并登回 Attendant Console ，现在 BLF 可以被显示。 

返回先前的演示 
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附录 B: 额外解决功能 

Cisco Unified Attendant Console 可用于多种编辑并有不再此演示中的额外的功能。 需要更多有关编辑和功能的，且查看每个版本的

数据表： 

http://www.cisco.com/en/US/products/ps7282/products_data_sheets_list.html 

 

您也能查看最终用户培训视频，请参阅在操作控制台： 

http://www.arcsolutions.com/north_america/solutions/products/cisco_oem_consoles.aspx 

 

http://www.cisco.com/en/US/products/ps7282/products_data_sheets_list.html
http://www.arcsolutions.com/north_america/solutions/products/cisco_oem_consoles.aspx

